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Introduction 

Welcome to the HEC-ResSim Quick Start Guide.  This document will take you through 

the steps needed to develop a reservoir simulation model using HEC-ResSim.  Use this 

document to get a quick overview of the program and its basic features.  For more 

detailed information, refer to the HEC-ResSim User’s Manual [references to the HEC-

ResSim User’s Manual are given in this type of formatted text to provide you with a cross 

reference for locating additional information].  This guide provides basic steps for using 

the Graphical User Interface (GUI) to enter data, run simulations and view results.  

“New” features (from Version 3.1 to Version 3.3) are indicated as highlighted text. 

 

Starting the Program 
  

  Once HEC-ResSim has been installed on your PC, start the program as follows: 

 

  From Microsoft Windows - 

 

On your desktop, double-click on the HEC-ResSim icon or, from the 

Start menu, select All Programs → HEC → HEC-ResSim → HEC-

ResSim 3.3. 

 

 

When you first start the program, you 

will see an introductory screen 

containing the version and contact 

information.  This screen will disappear 

after a few moments.  However, the 

same information is available from 

ResSim’s Help menu by selecting the 

About option. 

 

 

 

 

 

 

 

Exiting the Program  
 

To exit the program, from the File menu on the Main Window, select Exit.  The 

program will prompt you to save all files. 
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First, Some Terminology… 

What is a Watershed? 
In HEC-ResSim terminology, a Watershed is a collection of data associated with a 

particular reservoir system or study [Chapter 2].  Types of data include Watershed 

Setup (Configurations) [Chapter 3], Reservoir Networks (including Operation Sets 

[Chapter 10] and Alternatives [Chapter 14]), and Simulations [Chapter 15].  After 

performing a Simulation, which will include one or more Alternatives, you can view 

and print results in both graphical and tabular form [Chapters 16 & 17 and Appendix E].   

What are Watershed Locations? 
A Watershed Location is the place on disk where you can store watersheds; also 

called a Shortcut, model directory, or working directory [Section 3.2.1].  You can 

have multiple watershed locations, although a given watershed cannot span multiple 

locations.  Each watershed location should be given a descriptive name, such as My 

Watersheds or General Projects, and a path specification that identifies the directory 

where you want to create and edit your watershed data. 

 

 

Figure 1. Tools Menu, Options Editor, Watershed Locations 

 

Before you can create or open a watershed, you must define at least one watershed 

location.  Do so by selecting Options from the Tools menu.  The Options Editor will 

appear as shown in Figure 1.  The Shortcuts tab of the Options editor is used to 

define Watershed Locations.  To add a new location to the list, press the Add 

Shortcut… button.  The Add Shortcut dialog will appear (Figure 2).  In the 

Location field, you can enter the full path to the working directory or you can 

Browse to the area on disk where you want to build your watershed.  Next, enter the 

name you are giving this location in the Name field and press OK.   
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Figure 2. Add Shortcut (Watershed Location) dialog 

What are Modules? 
 

The ResSim program is divided into separate sets of functions called modules 

[Section 2.2].  Each module provides access to specific types and directories of data 

within the watershed data tree.  The three modules within the ResSim program are: 

• Watershed Setup [Section 2.2.1 Chapters 3—5] 

• Reservoir Network [Section 2.2.2 and Chapters 6—14] 

• Simulation [Section 2.2.3 and Chapter 15] 
 

Figure 3 provides a graphical illustration of concepts and typical workflow through 

the three modules that make up HEC-ResSim.  Refer back to this figure as you learn 

more about the function of each module to help keep the concepts organized. 

 

 

Figure 3. ResSim Module Concepts 

A. Watershed Setup Module 

 

The opening window of the Watershed Setup Module is shown in Figure 4.  As 

you can see, most menus and tools are inactive (grayed-out).  They will remain so 

until a watershed is created or opened, which can be done by selecting New 

Watershed or Open Watershed from the File menu in the Watershed Setup 

Module. When a watershed is created, ResSim constructs a directory tree where 
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all files pertaining to the watershed will be stored.  Those files specific to the 

ResSim model (and not shared by other models like HMS, FIA, etc.) are stored in 

the watershed directory tree in a subdirectory named rss. 

 

 

Figure 4. Watershed Setup Module, Opening Window 

 

The Watershed Setup Module main window has the following menus: 
 

File  This menu will appear in all modules and most editors. In the main 

window, it always includes the options Open Watershed, Save 

Watershed, Save Map As, and Exit.  In the Watershed Setup 

Module, the option New Watershed is also included.  These 

options relate to the overall watershed data. 
 

Edit  This menu will appear in all modules and most editors.  This menu 

is module specific.  The edit options will be relevant to data 

elements currently available for modification.  The edit options 

available in the Watershed Setup module include:  Watershed 

Data, All Impact Areas, Projects, Drawing Properties, and 

Allow Editing. 
 

View  View options relate to all modules.  Options include adding 

Layers that are displayed in the map region, selecting the Unit 



HEC-ResSim 3.3 Quick Start Guide 

February 2021 5 

System for viewing, and selecting whether or not to show the Grid 

Lines in the map region. 
 

Watershed  This menu is only available in the Watershed Setup Module.  

Watershed options relate to the entire watershed, as well as to the 

individual configurations and the stream alignment.  Options 

include Configuration Editor, Update Computation Points, 

Import and Export (of Stream Alignment), and Save 

Configuration. 
 

Reports  Predefined reports and tables are listed in this menu. This menu 

appears in all modules, but its content is module specific.  In the 

Watershed Setup and Reservoir Network Modules, most of the 

reports detail input data.  In the Simulation Module, the reports 

detail simulation results. 

 

Tools  User setting options, properties, and extended tools such as HEC-

DSSVue and scripting are found here. 

 

Help  This menu provides access to the user documentation in pdf form.  

It also allows for the installation of example watersheds, after a 

watershed location has been defined [Section 3.2.1].  This option 

also gives the ResSim version information.   

 

 

Figure 5 shows the main window of the Watershed Setup Module after opening 

an existing watershed (HayesBasin).  A map region occupies the majority of this 

window, where the user must place the project elements (e.g., reservoirs) onto the 

stream alignment (all configurations that will be defined for this watershed will be 

on this alignment).  A background map can be added (but is not required) to the 

map region to help identify the streams for the alignment. 
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Figure 5. Watershed Setup Module, Opened Watershed, HayesBasin 

 

 

B. Reservoir Network Module 

 

The Reservoir Network Module is used for editing element (e.g., reservoir, 

computation point, and routing reach) data and placing additional elements onto 

the stream alignment.  Figure 6 shows an example of the Reservoir Network 

Module window for HayesBasin.  This example shows a Network named 

“NormalNetwork2” which was created by selecting New from the Network menu 

and selecting “StandardConfig” from the Configuration list.  A map region 

occupies the majority of this window, where the user must place Routing Reaches 

(required for connectivity) and Diverted Outlets (if appropriate) onto the stream 

alignment. 

 



HEC-ResSim 3.3 Quick Start Guide 

February 2021 7 

 

Figure 6. Reservoir Network Module, HayesBasin 

 

Element data is edited within the Reservoir Network Module.  First, select the 

appropriate tool from the tool bar on the left side of the window, then right-click 

on the element.  A shortcut menu appears with options to edit data defining the 

element.  Alternatively, select the general pointer tool  from the top of the 

toolbar on the left side and right-click on any element to view the shortcut menu. 

 

The menus that are new or unique to the Reservoir Network Module are listed 

and described below:  

 

Edit  This menu will appear in all modules and most editors.  The edit 

options available for reservoir networks include:  Reservoirs, 

Reaches, Junctions, Diversions, and Reservoir Systems, State 

Variables, Import Element Properties, and Allow Network 

Editing. 

 

Network  Network options are used in defining the network and 

configuration to be used.  Options include New, Open, Edit, Save, 

Save As, and Rename.  Also included are the Update Network 

from Configuration, Import Network, and Delete Networks 

options. 
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Alternative  The only option in this menu is Edit.  This opens the Alternative 

Editor, which will enable you to create, edit, and save alternatives. 

 

Reports  Predefined reports and tables are listed in this menu. Options 

include Reservoir List, Reach List, Junction List, and Diversion 

List.  An Advanced option is also available that shows a summary 

table of the Network elements and their connectivity, as well as a 

listing of Nodes in the network. 

 

C. Simulation Module 

 

The Simulation Module is designed to facilitate the analysis phase of reservoir 

modeling.  In this module you will create and run Simulations.  Each Simulation 

is a combination of the time window and Alternatives that you want to analyze. 

 

A view of the Simulation Module is shown in Figure 7.  This view shows an open 

Simulation (Oct_1999_Event) with one of the Alternatives (StandNorm2) of the 

Simulation set as active (bolded alternative). 

 

 

Figure 7. Simulation Module, HayesBasin 
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 The checkmark on the left side of the Alternative indicates that the user 

requests that the results are to be shown (plots, tables, etc.).  Results for multiple 

alternatives can be shown for comparison purposes by checking all alternatives of 

interest.  However, only one alternative can be set to active (bold) at a time and 

that alternative’s data is reflected in the map region and is, therefore, available for 

editing. 

 

The menus that are new or unique to the Simulation Module are listed and 

described below:  

 

Edit  This menu will appear in all modules and most editors.  The edit 

options available for the Simulation Module include:  Script List 

selection, Set Active Alternative, and editors for Reservoirs, 

Reaches, Junctions, Diversions, Reservoir Systems and State 

Variables.  Also available is the Run editor for the active 

alternative. 

 

Simulation  Simulation options are provided for creating, opening, editing, 

saving, and running simulations.  Options include New, Open, Re-

Open, Close, Simulation List, Replace from Base, Edit, Save, 

Delete, Info, and Run Manager.  Also, Release Overrides can be 

defined from this menu. 

 

Alternative  The only option in this menu is Edit.  This opens the Alternative 

Editor, which will enable you to edit and save alternatives. 

  

Reports  Predefined reports and tables are listed in this menu. Options 

include Reservoir Summary, Flow Summary, Power Summary, 

Gates Summary, Stage Summary and Release Decision report.  

Also available from this menu are User Reports, Compute logs, 

and Network Element Lists (Reservoir, Reach, Junction, and 

Diversion, as well as the Advanced Network Connectivity 

Summary). 

 

Some Other Useful Terms 
 

The following is a list of terminology commonly used throughout the ResSim Quick 

Start Guide.  This page may be useful as you progress through the manual.  

 

 

Alternative An alternative is a specific composition of watershed system 

characteristics and necessary data to perform a scenario-based 

simulation. 
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Component In ResSim, a component, or element, refers to a piece of the 

watershed model, such as a reservoir, tributary, stream node, 

junction, or computation point and the associated physical data. 

 

Computation 

Point 

ResSim allows the user to add computation points on the stream 

alignment.  These are placed at locations where the model will need 

information that is not generated by the placement of projects.  

Examples include stream gage locations, control points, confluences, 

and inflow points. 

Configuration In brief, a Configuration is the identification of a “set” of projects 

within your watershed that you want to model in your watershed.  If 

more than one set of projects will be considered in a study, then more 

than one Configuration will be needed.  While you add projects to 

your Configurations, a special “superset” (named Study) is 

developed by the program to contain all projects from all 

Configurations in the watershed.  If multiple programs (e.g., HEC-

HMS, HEC-FIA, HEC-RAS, etc) are going to be applied to your 

watershed, then Configurations should be developed by the modeling 

team before the models for an individual program are prepared. 

Operation Set In ResSim, an Operation Set is the operation plan or scheme upon 

which a reservoir bases its decisions regarding how much water to 

release at each time step of a simulation run [Chapter 10].  Key 

elements of an Operation Set include reservoir zones, Guide Curve 

selection, and rules.  A reservoir can have more than one Operation 

set, but only one can be active within an alternative. 

 

Projects Within ResSim, a project primarily refers to a reservoir.  However, a 

levee is also considered a project.  A configuration reflects a 

collection (“set”) of projects. 

Simulation In ResSim, a simulation is where the computations are performed for 

alternatives within a user-defined time window.  Results of 

alternatives are available in a simulation. 

  

 

Getting Down to Business… 

The basic steps for developing a reservoir model are outlined below.  These steps are 

illustrated in the sections that follow. 

Steps for Developing a Reservoir Model 
 

Developing a ResSim model entails the following steps: 

 

A. Set Up the Watershed 

1. Create/Open a Watershed [Sections 3.2 and 1.3] 

2. Add Map files [Section 3.3 and Appendix B] 



HEC-ResSim 3.3 Quick Start Guide 

February 2021 11 

3. Draw a Stream Alignment [Chapter 4] 
4. Create a Configuration [Section 3.4] 

5. Place Project Elements into the Configuration [Section 3.4.3] 

 

B. Develop a Reservoir Network 

1. Import/Create/Open a Network [Sections 6.2 and 12.9] 

2. Add Routing Reaches [Section 7.2] 

3. Edit Junction Properties [Section 7.1] 

4. Edit Reach Properties [Section 972] 

5. Edit Reservoir Properties 

a. Physical Data [Chapter 9] 

b. Operations Data [Chapters 10 and 11] 

c. Observed Data [Sections 8.3 and 14.10] 

 

C. Define Alternatives 

1. Create an Alternative [Section 14.3] 

2. Define the Run Control Specifications [Section 14.4] 

3. Select the Operation Scheme(s) [Section 14.5] 

4. Specify Lookback Conditions [Section 14.8] 

5. Identify Time-Series data records from DSS [Sections 14.9 and 14.10] 

6. (Optional) Define Hotstart Options [Sections 14.11] 

 

D. Perform a Simulation 

1. Create/Open a Simulation [Sections 15.2 and 15.3] 

2. Select/Activate Alternatives [Section 15.4.1] 

3. Compute [Section 15.4] 

4. View Results [Chapters 16 & 17 and Appendix E] 

5. (Optional) Specify Overrides [Section 15.7.3] 

6. Manage Simulation Data [Section 15.8] 

 

A. Set Up the Watershed 

 

1. Create/Open a Watershed 

In the Watershed Setup Module, choose New Watershed from File menu.  

The new watershed screen will appear, as illustrated in Figure 8.  Enter a name 

for your watershed and a detailed description in the appropriate fields.  From the 

Location list, select where you want your watershed stored.  If the Location list 

is empty, press Cancel, and go back to page 2 to see how to add a Watershed 

Location.  Use the Units list to select the unit system that the watershed will use 

when storing its data.  The available unit systems are English and SI (i.e., US 

Customary and International System of Units).  Then select a Time Zone.  The 

watershed time zone is always specified as some offset from GMT, which does 
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NOT recognize Daylight Savings Time.  When you have completed all fields, 

press OK. 

 

 

Figure 8: New Watershed 

 

2. Add a Map 

When a watershed is created, ResSim constructs a whole directory tree.  One of 

the subdirectories in the watershed tree is the maps directory.  Using a file 

system viewer (like Windows Explorer), copy the files you will use as 

background maps into the maps directory of your watershed: 
 

<watershed location>\base\<watershed name>\maps 
 

The supported types of map files include DLG (USGS Digital Line Graphs), 

SHP (ArcView® shapefiles), DXF (Autocad® Digital Exchange Format), DEM 

(USGS Digital Elevation Models), IMG (Raster Image), ASC (ArcInfo® ASCII 

grid), and NET (ASCII NetTIN) [Appendix B]. 

 

To display a map in the watershed, go to View, Layers…  This will open the 

Layers Editor.  First, make the layers editable by selecting Allow Layer 

Editing from the Edit menu.  This is illustrated in Figure 9.  Then, from the 

Maps menu, select Add Map Layer.  This will open another window from 

which you can select the map file you want to view. You can select and deselect 

maps by un-checking the checkbox next to the map name.  

 

 

Figure 9: Allow Layer Editing 
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Note that it is not necessary to display a map.  However, it is convenient to have 

the map as a guide when creating stream alignments [Chapter 4]. 

 

Zoom.  To zoom in or out on the map area, select the zoom tool  on the left 

side of the window.  To zoom in, click and drag over the desired viewing area.  

To zoom out, right-click until the desired viewing area is visible.  Alternately, to 

zoom out to the original display, go to View, Zoom to All. 

 

3. Draw a Stream Alignment 

The next step is to create a stream alignment on which stream reaches and 

reservoirs can later be located.  First, ensure that you are working in the 

Watershed Setup Module.  If you aren’t, then be sure to select Watershed Setup 

from the Module list.  Second, from the Edit menu, activate Allow Editing (a 

check mark will appear to the left and the “yellow lock” in the upper right 

portion of the window will lock to indicate that you are in the edit mode).  

Alternately, the yellow lock  can be pressed to allow editing. 

 

 

Figure 10: Drawing a Stream Alignment 

 

• Create a Stream Alignment Element.  The Stream Alignment must be 

created from upstream to downstream.  Select the stream alignment tool 

 from the tool bar along the left side of the map region.  Hold down 

the control (CTRL) key and click to place successive points along the 

stream alignment.  To terminate the stream element, release the CTRL 

key and click to place the last point of the stream.  As shown in Figure 
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10, a tributary may be connected to a stream by following the same 

procedure as above and terminating the stream at the point of connection 

to the existing stream. 

 

• Edit a Stream Element.  Select the stream alignment tool  and 

double click on the stream element to be edited.  The stream will change 

color, and points will appear where each stream point is defined.  These 

points can be moved to realign the stream by positioning the cursor over 

them and holding down the left mouse button and dragging.  New points 

are added to a stream by clicking on the stream while holding down the 

CTRL key.  Remove points from a stream by clicking over an existing 

point while holding down both the SHIFT and CTRL keys.  An entire 

stream can be deleted by right-clicking on it and selecting Delete Stream 

Element from the shortcut menu.  Streams can be renamed by right-

clicking on the stream and selecting Rename Stream Element.  

 

• Define Stationing.  The green dots at the end of each stream in the 

alignment are Stream Nodes.  Their purpose is to define the stationing 

along the stream.  By default, the most downstream node will get a 

stream station of zero, and the node at the upstream end will get a stream 

station value determined by the length of the stream line in the 

coordinate system of the map region.  However, these default values can 

be changed to more accurately describe the stream.  Using the stream 

node tool  right-click on a stream node and select Edit Node.  In the 

editor that appears, uncheck the “Use Default Stationing” box then 

update the value of the station to represent the appropriate real world 

station value of that representative point.  If you change the stationing of 

the upstream node, then you may need to edit the most downstream node 

to reset its station to zero (0.0).  Stationing along a stream will be 

determined proportionally based on the station values of the bounding 

nodes.  Interior stream nodes can be added to a stream to more 

accurately define distances along a stream and to locate known river 

station landmarks. To do so, select the stream node tool, then while 

holding down the CTRL key, click those locations on a stream where 

you want to place a stream node. 

 

4. Create a Configuration.   

Before adding reservoirs and computation points, a Configuration must be 

defined [Section 3.4].  In brief, a Configuration is the identification of a “set” of 

projects that you want to model in your watershed.  If more than one set of 

projects will be considered in a study, then more than one Configuration will be 

needed.  While you add projects to your Configurations, a special “superset” 

(named Study) is developed by the program to contain all projects from all 

Configurations in the watershed.  If multiple programs (e.g., HEC-HMS, HEC-

FIA, HEC-RAS, etc) are going to be applied to your watershed, then 
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Configurations should be developed by the modeling team before the models for 

an individual program are produced. 

 

• Make the Configuration Editable.  Before you can create or modify a 

Configuration, you must make it editable.  To do so, select Allow 

Editing from the Edit menu (or click the “unlocked”  yellow lock, 

which “locks”  the configuration (allowing you to perform editing).  

In other words, this option turns on (or off) the ability to make changes 

to the Configuration. 

 

• Create the Configuration.  From the Watershed menu, select 

Configuration Editor.  From the Configuration menu in the 

Configuration Editor that has opened (Figure 11), select New.  In the 

new configuration window, enter a Name and Description for the 

Configuration and select a time step from the Time Step list and press 

OK.  Then, click OK in the Configuration Editor. 

 

 

Figure 11: Configuration Editor 

 

5. Place Project Elements into the Configuration.   

The next step is to place projects into the watershed.  The projects you place 

will be added to the current Configuration as identified in the Configuration 

field at the top of the window. 

 

• Draw Project Elements.  Verify that you have selected the appropriate 

configuration to which you will be adding projects.  Select the 

appropriate tool to add projects.  Each project, when placed, will create 

one or more computation points.  When using the Reservoir Tool  to 

place reservoirs, hold down the CTRL key to place the                    



HEC-ResSim 3.3 Quick Start Guide 

16 February 2021 

upstream point(s) of the reservoir, then release the CTRL key and place 

the downstream point.  A Name New Reservoir window will appear so 

that you can name the reservoir. 

 

Another useful tool is the Computation Point Tool .  Use this tool to 

place additional computation points by holding down the CTRL key and 

clicking on additional locations as needed.  As you place additional 

computation points, you will be prompted to name them (when placed at 

the junction of two or more streams, you will need to select which 

stream the computation point should be placed on).  Placing reservoirs 

on the stream alignment also creates computation points at the upstream 

and downstream extents of the reservoir using automatically generated 

names.  Be sure to rename each of these points so it can be easily 

identified from a list when the map region is not visible.  To do so, right-

click on the computation point, select Rename Computation Point 

from the shortcut menu and enter a new name in the window as shown 

in Figure 12. 

 

 

Figure 12: Rename Computation Point 

 

• Save the Configuration.  When you are finished adding elements to the 

Configuration, be sure to save it and turn off editing.  Select Save 

Configuration from the Watershed menu to save, then “unlock” the 

Configuration lock (yellow lock button) to toggle off the editability of 

the Configuration.  A fairly simple Configuration (named 

StandardConfig) is shown in Figure 13. 
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Figure 13: A Simple Configuration, StandardConfig 

B. Develop a Reservoir Network 

 

With a stream alignment in place and one or more configurations defined, a 

network of reservoirs and stream routing reaches can be created.  A summary of 

the basic steps is presented in the following paragraphs.  From the Module list, 

select Reservoir Network. 

 

1. Import a Reservoir Network. 

To use the Import Network Wizard, perform the following steps: 

• From the Network menu in the Reservoir Network module, select 

Import Network…. The Import Network Wizard – Step 1 of 6 will 

appear. Select the Watershed that contains the network from which you 

would like to import the entire network physical and operational data. 

The box on the left side of the dialog contains names of Watershed 

Locations that have been specified as Model Directories.  The box on the 

right side of the dialog contains all the watersheds that can be found in 

each Watershed Location. 
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Figure 14 Import Network Wizard – Step 1 of 6 Select Watershed from 

which to Import 

 

• Select Next and Import Network Wizard – Step 2 of 6 will appear. 

Select the network from which you would like to import all elements by 

highlighting the Network Name. 

 

 

Figure 15 Import Network Wizard – Step 2 of 6 Select Network from 

which to Import 

 

• Select Next to continue and the Import Network Wizard – Step 3 of 6 

will appear. Enter a New Reservoir Network Name and Description. 
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Figure 16 Import Network Wizard – Step 3 of 6 Define New Network 

Name and Description 

 

• Select Next to continue and the Import Network Wizard – Step 4 of 6 

will appear. Assign Stream Names by drop-down menu one at a time, or 

all at once by selecting the Assign Stream Names button. Care is 

required in determining the connection of the Imported Element to the 

Stream.  If Imported Elements are associated with streams that are not 

connected, it is possible there will be erroneous downstream control 

rules added to upstream junctions. 

 

 

Figure 17 Import Network Wizard – Step 4 of 6 Assign Stream 

Names 

 

• Select Next to continue and the Import Network Wizard – Step 5 of 6 

will appear. Assign the network elements to their corresponding 
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watershed computation points by use of a drop-down menu for each 

imported element. 

 

 

Figure 18 Import Network Wizard – Step 5 of (Resolve 

Network Computation Points) 

 

• Select Next to continue and the Import Network Wizard – Step 6 of 6 

will appear. Review all of the information in the import summary. Check 

to ensure that all physical and operational data was successfully 

imported by reviewing the Import Summary and by viewing the various 

network element editors in the Reservoir Network module. 

 

 

Figure 19 Import Network Wizard – Step 6 of 6 (Import 

Summary) 
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2. Create/Open a Reservoir Network.   

As an alternative to Importing a reservoir network, you may also create a new 

network.  From the Network menu, select New.  The Create New Reservoir 

Network window will appear (Figure 14).  Specify a name and description for 

the network.  Then, select the Configuration on which this network will be 

based and click New [Section 6.2]. 

 

 

Figure 20: Create New Reservoir 

 

Reservoirs and computation points that were part of the selected configuration 

will automatically be created as elements in the Reservoir Network.  Reservoirs 

transfer directly.  Computation points appear as Junctions.  This is depicted in 

Figure 15. 

 

 

Figure 21: New Network Based on Configuration 

StandardConfig 

 



HEC-ResSim 3.3 Quick Start Guide 

22 February 2021 

Make the Network Editable. Before you can begin editing, you must ensure 

the network is editable.  To do so, select Allow Network Editing from the Edit 

menu (or press the “yellow lock” button  ). This option turns on (or off) the 

ability to make changes to the network. 

 

 
3. Add Routing Reaches, etc.   

Draw the additional elements needed to complete the connectivity of the 

reservoir network schematic [Section 7.2]. 

 

Draw Routing Reaches.  Select the Routing Reach Tool .  Hold down the 

CTRL key and click anywhere on the stream to place the upstream end of the 

reach.  Release the CTRL key and move the mouse along the stream and click 

again at a lower station on the stream to place the downstream end, as shown in 

Figure 16.  Routing reaches must be connected to an existing junction.  If you 

start or end a reach where there is no junction a junction will be created, and 

you will be prompted to first name the new junction and then name the new 

reach.  (Note: tributaries cannot connect to the middle of a reach; they must 

connect to a junction.) 

 

 

Figure 22: Drawing Routing Reaches 
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4. Edit Junction and Reach Properties.   

With a reservoir network schematic complete, the data for the model elements 

can be entered and saved. 

 

Edit Junction Properties.  With the pointer tool  or the junction tool  

selected, right-click on desired junction and select Edit Junction Properties.  

The Junction Editor will appear.  Select the Local Flow tab and input a name 

and factor for each external flow entering the junction (as shown in Figure 17).  

The name entered will appear during the Alternative definition to identify the 

local flow for time-series mapping.  Therefore, the name given on the Local 

Flow tab should be recognizable during the time-series mapping.  Flows must be 

supplied to headwater junctions and are optional at other junctions. 

 

 

Figure 23: Junction Editor 

 

To edit junction properties for other junctions without exiting this window, click 

Apply and then select another junction from the Name list or use the navigator 

buttons located in the upper right portion of the window.  Alternately, click OK, 

then right-click and Edit another junction. 

 

For each junction where you specify Local Flows, you will see a 

“halo” around the Junction element.  This provides you with a 

visual reference for ensuring local flows have been indicated for 

the appropriate locations in your watershed. 

 

Edit Reach Properties.  With the reach tool  or the pointer tool  selected, 

right-click on the desired reach and select Edit Reach Properties.  Select the 

routing method from the Method list (as shown in Figure 18) and fill in the 
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necessary parameters for the selected routing method.  The default routing 

method is Null Routing (no route). 

 

 

Figure 24: Reach Editor 

 

The Coefficient Routing method can be used to mimic most linear routing 

methods by representing the method as a series of coefficients for each time step 

of the routing extent.  Specifying a coefficient of 1.0 in the first row of the 

Coefficient table is the same as specifying a null routing. 

 

To edit another reach without exiting this window, click Apply then select 

another reach from the Reach Name list or use the navigator buttons to select 

another reach.  Alternately, click OK, then right-click and Edit another reach 

[Section 7.2]. 

 

5. Edit Reservoir Physical Properties.   

With the reservoir tool  or the pointer tool  selected, right-click on a 

reservoir, select Edit Reservoir Properties and the Reservoir Editor window 

will appear as shown in Figure 19. This editor has a tab panel with three tabs:  

Physical tab [Chapter 9], Operations tab [Chapters 10 and 11], and Observed 

Data tab [Section 8.3]. 

 

• On the Physical tab, a tree appears in the left panel of the window.  

Initially, two branches of the tree are shown:  Pool and Dam.  The Pool 

reflects characteristics of the reservoir storage while the Dam reflects the 

reservoir dam. 
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Figure 25: Reservoir Editor, Pool Data 

 

• Enter Pool Properties.  Click on Pool to enter the Elevation vs. Storage 

vs. Area data (as shown in Figure 19).  At least two rows are required for 

Elevation, Storage and Area data, with values increasing down the 

columns (no duplicate values).  The maximum elevation should not 

exceed the Elevation at top of dam, which is input when Dam is 

selected.  Pool losses can be specified by right-clicking on Pool and 

selecting Add Pool Evaporation and/or Add Pool Seepage [Section 

9.3.1]. 

 

• Enter Dam Properties.  Click on Dam in the reservoir tree.  The data 

area to the right of the reservoir tree will change to allow you to enter 

the data needed to define the dam [Section 9.4].  Before proceeding, take 

a look at the name of the dam.  The name is probably something like 

“Dam at My Main River.”  This is the default name the program gives to 

the dam.  It identifies the dam based on the name of the underlying 

stream upon which the dam was placed.  This enables the program to 

uniquely identify more than one dam within a reservoir.  It is a rare case 

when a reservoir has more than one dam, so feel free to rename the dam 

by right-clicking on the dam name and selecting Rename (as shown in 

Figure 20).  One suggestion is to name it Dam by removing the stream 

name.  Another possibility is to name the dam by its actual name (many 

reservoirs have a name for the pool and a different name for the dam; 

ResSim provides the ability to name each part individually). 
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• Enter the elevation and length of the dam in the relevant fields.  The 

composite release capacity table is not editable.  This table is 

informational and will be filled automatically as you add outlets to the 

dam. 

 

 

Figure 26: Reservoir Editor, Rename Dam 

 

• Add Outlets.  Physical Outlets can be added to the Dam by right-

clicking on the Dam.  Figure 20 illustrates the dam’s shortcut menu.  

Select Controlled Outlet to add a gate or other control structure to the 

dam [Sections 9.4.2 and 9.6].  You can rename the outlet by right-

clicking on the outlet and selecting Rename. 
 

A simple controlled outlet can be defined by entering a maximum release 

capacity curve for the outlet.  If a more detailed outlet definition is desired, 

press the Edit Gate Settings button.  The Gate Settings Editor will allow you to 

define a set of gate openings with Elevation vs. Maximum Capacity (flow) data.  

When finished, the release capacity table will show several more columns (as 

shown in Figure 21), one for each gate opening in the set you defined. 
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Figure 27: Reservoir Editor, Gated Outlet 

 

Select Uncontrolled Outlet to add an ungated emergency spillway to the dam 

[Section 9.9].  For an Uncontrolled Outlet, the spillway length and elevation are 

entered along with either a Weir Coefficient or an Elevation vs. Outflow 

relationship.  The spillway elevation must be at or below the Elevation at top 

of dam and above the minimum storage elevation.  Figure 22 shows the 

window for entering data for an Uncontrolled Outlet. 

 

 

Figure 28: Reservoir Editor, Uncontrolled Outlet (Spillway) 
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In addition to Controlled and Uncontrolled Outlets, the following components 

can also be added to the Dam: 

 

Leakage [Section 9.4.5], 

Outlet Group [Section 9.4.6], 

Tailwater Elevation [Section 9.4.7], 

Power Plant [Section 9.7], and 

Pump [Section 9.8]. 

 

In addition to adding physical components to the Dam, there is an advanced 

option for specifying Pulse Flow Options [Section 11.3.5]. 

 

 

6. Edit Reservoir Operational Properties.   

 

After adding the reservoir physical properties, add the operational information 

via the Operations tab of the Reservoir Editor.  When the Operations tab is 

initially chosen, a screen similar to Figure 29 will appear.  A new operation data 

set must be created before operations data can be entered [Section 10.2.1]. 

 

 

Figure 29: New Operation Set 

• Create an Operation Set.  Select New from the Operations menu and 

give the new operation set a name (as illustrated in Figure 23).  An 

Operation Set is the operation plan or scheme upon which a reservoir 

bases its decisions regarding how much water to release at each time 

step of a simulation run [Section 10.2]. 

 

• Operation Zones.  Once an Operation Set is created, then a set of 

“default” reservoir zones is generated:  Flood Control, Conservation, 

and Inactive.  Additional zones (e.g., Top of Dam) can be added by 
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selecting New from the Zone menu.  Top of zone curves must be 

entered, as no default values are available [Section 10.3]. 

 

• Operation Rules.  To add a rule to a zone, highlight the appropriate 

zone and select New from the Rule menu.  In the new rule window 

(Figure 24), enter a name for the rule, then select the pool, dam, outlet, 

or outlet group for which the rule will apply (Operates Release From), 

then select the rule type from the Rule Type list, and then click OK 

[Chapter 11]. 

 

 

Figure 30: New Operating Rule 

Rule types differ depending on where the rule is applied (pool, dam, or outlet) 

[Section 11.1.1].  The rules that apply to the Reservoir Pool, are typically relevant 

to Storage or Elevation, whereas the rules that apply to a Dam or an Outlet are 

relevant to Flow. 
 

Rules that apply to Reservoir Pool, Reservoir Dam, Controlled Outlets, 

Outlet Groups, and Diverted Outlets (i.e., all ‘Operates Release From’ 

elements, except Pumps) 
 

❖ Release Function, Maximum, Minimum or Specified Release as a 

function of Date, Date and Time, Model Variable, or External Variable 

[Section 11.2]. 

❖ Flow Rate of Change Limit, Allowable change when increasing or 

decreasing release values [Section 11.5]. 

❖ Script, User-defined scripting available that dramatically increases the 

flexibility of reservoir operations. [Section 12.3]. 
 

Rules only for the Reservoir Pool include the following: 
 

❖ Downstream Control Function, Minimum or Maximum Flow or 

Stage target or constraint (at a downstream location) as a function of 

Date, Date and Time, Model Variable, or External Variable [Section 

11.3]. 

❖ Induced Surcharge, Special flood control operation using gate 

regulation parameters [Section 11.4]. 

❖ Elevation Rate of Change Limit, Allowable change when increasing or 

decreasing pool elevation values [Section 11.6]. 

❖ Tandem Operation, Release based on balancing pool with a 

downstream reservoir [Section 11.9].  
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Rules only for the Power Plant include the following: 

 

❖ Hydropower - Power Guide Curve, Energy Requirement (expressed 

as % Plant Factor) is dependent on the available power storage.  

Optional Daily and Hourly distributions can be specified [Section 

11.7.1]. 

❖ Hydropower - Schedule, Monthly Firm Energy Requirements (specified 

as Monthly MWH or % Plant Factor) with optional Daily and Hourly 

distributions [Section 11.7.2]. 

❖ Hydropower - System Schedule, same requirements as above except with 

additional options for specifying the power generation pattern and for 

identifying reservoirs whose power generation can be used to meet system 

requirement [Section 11.7.3]. 

❖ Hydropower - Time Series Schedule, Energy Requirement as defined by 

user-supplied time-series data [Section 11.7.4]. 
 

Rules only for Pumps include the following single rule: 
 

❖ Pump Schedule, Pumpback storage operation using user defined schedule 

[Section 11.8]. 

Depending on the rule type, you will need to enter data to define the 

rule.  A screen will open in the editor to allow you to enter the required 

data for each rule.  The rules and storage zones are displayed in a tree 

on the left side of the window (as shown in Figure 25).  Once a rule 

has been defined, it can be included in more than one zone by selecting 

Use Existing from the Rule menu.  Similarly, a rule can be removed 

from a zone by selecting Remove from Zone.  A rule can be deleted 

from the operation set by selecting Delete.  However, when a rule is 

Deleted, then it is no longer available to any of the zones; therefore, 

caution should be used when actually deleting a rule. 
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Figure 31: Zones and Rules Panel 

When finished entering data for a reservoir, click OK.  To edit a different 

reservoir without exiting the reservoir editor, click Apply and select another 

reservoir from the Reservoir list. 

 

• The Observed Data tab is used to indicate that observed data is 

available for comparison purposes [Section 10.23].  If the Observed box 

is “checked” in the table (as shown in Figure 26), then there will be a 

corresponding entry in the Observed Time-Series mapping table when 

an Alternative is created [Section 13.9]. 

 

5. Save the Reservoir’s Physical and Operations data, Junction 

information, Routing criteria, etc...  From the Network menu select Save.  

It is a good idea to do this frequently. 
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Figure 32: Observed Data Tab 

C. Define Alternatives 

 

Create an Alternative.  An Alternative consists of a Reservoir Network, an Operation 

Set for each reservoir in the network, a definition of initial conditions, and a mapping all 

time-series records to identified local inflows, etc.  To create an alternative: 

 

1. From the Alternative menu (in the Reservoir Network module) select 

Edit [Section 13.2]. 

2. In the Alternative editor, ensure that the appropriate Configuration name is displayed 

from the list of available configurations.  Then, from the Alternative menu, select 

New (as shown in Figure 27). 

3. In the New Alternative editor, enter a name for the Alternative in the Name box and a 

description in the Description box.  Select a Reservoir Network from the list and 

click OK. 

 

All of the relevant fields in the Alternative Editor will become active [Section 13.3]. 
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Figure 33: Alternative Editor, Create New Alternative 

 

4. The Run Control tab (Figure 28) allows you to specify the Time Step and Flow 

Computation Method to be used in your simulation(s) [Section 13.4]. 
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Figure 34: Alternative Editor, Run Control Tab 

 

5. In the Alternative editor, select an Alternative.  On the Operations tab, select an 

Operation Set for each reservoir [Section 13.5].  This can be accomplished in the 

Operation Set column by selecting (for each Reservoir) the operation set from the list, 

as shown in Figure 29. 
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Figure 35: Alternative Editor, Operations Tab 

 

6. On the Lookback tab [Section 13.7], select the initial conditions Type (Times-Series 

or Constant) from the list for each Location listed, as shown in Figure 30.  This is 

similar to selecting the operation set per reservoir.  For Variables defined as 

Constants, enter a constant Value for the Elevation or Release. 

 

 

Figure 36: Alternative Editor, Lookback Tab 
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7. On the Time-Series tab [Section 13.8] select a row in the time-series mapping table 

(as shown in Figure 31).  Each row in the table represents a required input for a local 

flow location (specified in the Local Flow tab within the Junction editor), an 

element/parameter you have defined on the Lookback tab as Time Series, or a Time 

Series that is referenced in the Operation rules.  To attach a time-series record to the 

selected location, press the Select DSS Path button. 

 

 

Figure 37: Alternative Editor, Time-Series Tab (for Mapping Data) 

The DSS path selector window will appear as shown in Figure 32.  Open a DSS file, 

use the parts filters to organize the catalog listing, and select a record.  To get the 

selected record to map back to the alternative editor, press the button labeled Set 

Pathname. 

 

 

Figure 38: DSS Time-Series Record Selector 



HEC-ResSim 3.3 Quick Start Guide 

February 2021 37 

8. On the Observed Data tab [Section 13.9], using the same procedure as the Time-

Series mapping described above, select optional time-series records for use in 

comparing with computed results. 

 

9. Typically, the Lookback period is used for warming-up the state (i.e., setting initial 

conditions) of the watershed for an alternative.  However, instead of using the 

Lookback period and associated data for determining the system state, you can save 

(and subsequently use) the data from one simulation to another simulation by using 

the optional Hotstart options (Figure 33).  Use the Hotstart as a way of assigning a 

previously simulated watershed state to another simulation.  In order to use the 

Hotstart option, the user must first run a simulation that saves system state data to 

“Hotstart” files [Section 13.10]. 

 

 

Figure 39: Alternative Editor, Hotstart Tab 
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Steps for Performing a Simulation 
 

Once the reservoir system data are entered, the model can be configured for a 

Simulation.  From the Module list, select Simulation.  Model elements of a 

Reservoir Network will not display in the map region until a Simulation is created or 

opened and an Alternative has been made active. 

 

A. Create/Open a Simulation.   

To create a Simulation, from the Simulation menu select New.  The window 

illustrated in Figure 34 will open [Sections 14.2 and 14.3]. 

 

 

Figure 40: Simulation Period 

• Enter a Start Date & Time, a Lookback Date & Time, and an End Date & 

Time. 

• Enter a name for the Simulation in the Name box.  A default name is generated 

based on the Start Date and Time.  You can use the default name or you can 

change it to a more meaningful name.  You can also enter a Simulation 

Description. 

• Select a Time Step from the list. 

• Select one or more applicable Alternatives for the Simulation and click OK. 
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B. Set Alternative to be Active.   

In the “tree list” of alternatives for the simulation (on the right side of the screen), 

right-click on the desired alternative and select Set as Active.  At this point, the 

model elements of the Reservoir Network will be displayed in the map region 

reflecting the active (notice bolded name) alternative [Section 14.4.1]. 

 

C. Compute.  

After all data and parameters have been input 

as desired, click on the Compute “Name of 

Alternative” button in the control panel of the 

Simulation Module’s main window to perform 

the computations [Section 14.4.2].   

A compute window will appear showing status 

messages and program progress.  When the 

computation is finished, a "Compute 

Complete" message will appear and the status 

bar will read 100%.  Click Close to close this 

window.  Note:  You can stop the compute process before the compute is complete by 

clicking on Stop Compute. 
 

7. View Results.   

Model results can be reviewed from three different approaches [Section 14.5 and 

Appendices E & F]. 
 

• Plots.  On the model schematic you can right-

click on a model element to get a menu list.  

Included on the list will be one or more plot 

options.  Select the option by clicking on it.  

The default plot will display.  The plotted 

results can be tabulated by selecting Tabulate 

from the plot’s File menu [Section 14.5.2]. 
 

• Summary Reports.  From the Reports menu in the Simulation module, there is a 

list of Summary Reports for the model simulation [Section 14.5.3].  The 

Reservoir, Flow, Power, Gates, and Stage reports provide Average, Maximum 

and Minimum values for the simulation.  The Release Decision summary report 

provides the current zone and limiting operating rule for each reservoir for all 

time periods of the simulation. 
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• DSS Viewer.  When HEC-

DSSVue is selected from the Tools 

menu, a DSS file is opened that 

contains the results of the 

simulation [Section 14.8 and 

Appendix E].  A list of pathnames is 

provided but a screened list can be 

obtained by selecting a pathname 

part from the lists in the Search by 

Parts section of the window.  To 

select records to be displayed, 

highlight the pathnames and click 

on the Select button.  After one or more records are selected, the buttons for plot 

and tabulate become active.  Click either button to generate the associated output. 

 

8. Specify Overrides.   

Once you have completed a simulation, you can 

override model results by specifying either the reservoir 

Elevation Target, or Releases (per outlet), or Capacity 

Factors (per outlet), or Storage (or Elevation) values for 

some (or all) of the time steps [Section 14.6.3].  ResSim 

will use the values you specify for Elevation Target and 

Release Overrides, within the physical limits of the 

reservoir (i.e., the physical rate-of-change, the release 

capacity and the amount of water available in the 

reservoir may preclude ResSim from using your 

override values).  To specify the override values, select Overrides from the 

Simulation menu in the Simulation module for the desired alternative; or, you can 

select the Overrides button by right-clicking on the “Active Alternative” and 

selecting Edit → ResSim from the shortcut menu and then click on the Overrides 

button.  The Overrides Editor will open (Figure 35). 
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Figure 41: Overrides Editor 

To specify override values for the “selected reservoir” (see 

Reservoir list at top of Overrides editor), do the following: 

• Select either the Elevation Target or Release or Capacity or 

Storage overrides tab. 

• To revise a single value, double-click in the cell you want to 

revise and enter the new value. 

• To revise multiple adjacent values: 

 

1. Point and click on the first cell, then drag your mouse or 

shift-click to highlight the cells to be revised. 

 

2. Right-click on the highlighted cells, and select Fill 

from the shortcut menu.  The Table Fill Options dialog 

box will open. 

 

 

 

 

3. Select the appropriate fill option in the Table Fill Options dialog box, then 

click OK.  The revised values will reflect the fill option you selected.  Also, the 

color of the revised values changes from black to blue and the mini-plot shows 

the revised values as a red line. 

• For those time steps where you do not specify override values, ResSim uses 

the reservoir rules to determine the reservoir release values.  After running 

a simulation using your override values, you may decide to no longer use 

some, or all, of your override values.  If so, you can use the Unspecify and 
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Unspecify All buttons to indicate that you want ResSim to determine the 

release values during the next compute. 

❖ Use the Unspecify button when you want release values to be based on 

the reservoir rules for some of the override values you have specified.  

Highlight the cells where you have specified override values (they are 

green in the Release Overrides table), then press the Unspecify button. 

❖ Use the Unspecify All button when you want all of the release values 

to be based on the reservoir rules and not have any overrides specified. 

• Use the Import button when you want to use a Time Series of override 

values.  The Import Overrides Time Series dialog box will open, which 

functions exactly like the Select Time Series Path dialog box used to 

select time-series records for an Alternative. 

 

9. Manage Simulation Data.   

There are two operations involved in managing Simulation data [Section 14.7].  You 

can save your data to the base directory to make it available for 

other Simulations, and you can replace data in a Simulation for a 

specific Alternative with data from the base directory.  See 

Appendix A of the ResSim User’s Manual for an overview of the 

ResSim directory structure, including a discussion of the base and 

simulation directories. 

 

• Save Data to the Base Directory.  When you edit model data 

from the Simulation Module, your changes apply only to an 

individual Alternative that is saved in your Simulation 

directory.  If you want your changes to be available for subsequent Simulations, 

you will need to save the data back to the Base directory [Section 14.7.1].  This 

can be done by right-clicking on the Alternative in the Simulation Control 

menu, set the Alternative as Active, and then select Save to Base Directory.  

This will make your changes to physical and operational data available in the 

Reservoir Network Module. 

 

• Replace Data from the Base Directory.  If, while editing 

data in the Simulation Module, you need to revert to the 

original Alternative data from the Network Module, you 

can replace the changed data in your Simulation directory 

with data from the Base directory. [Section 14.7.2]  This 

will make your original data (from the Reservoir Network 

Module) available in the Simulation Module, overwriting 

any changes you made to the selected alternative within 

the Simulation Module. 
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